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Obligatory:
= http://www.antlr.org

Optional:
= Cocktail www.cocolab.de, die Compiler-Toolbox fir die schnellsten
Compiler der Welt (kommerziell, Demoversionen erhéltlich)

= TaTaTree Grammars http://tata.gforge.inria.fr/ and all the tree theory

Oana Andrei, Helene Kirchner. A Port Graph Calculus for Autonomic Computing and
Invariant Verification. A. Corradini. TERMGRAPH 2009, 5th International Workshop
on Computing with Terms and Graphs, Satellite Event of ETAPS 2009, Mar 2009, York,
United Kingdom. Electronic Notes in Theoretical Computer Science, Elsevier. Preprint
<inria-00418560>, https://hal.inria.fr/inria-00418560
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1. Parser Generators in the Technical Space

Grammarware
» Analyzing the structure of

linear lists

» And transforming them to

1) Parsing as checker for trees

instance-of
2) Antlr as example

3) Example pocket computer
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Q10: The House of a Technical Space
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Q7b: Phases of a Source Code Importers into a Repository
and the Generating Tools
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Q8: Phases of Compilers and Software Tools and

Generators
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Rpt.: Use of Generated Importers and Exporters in Modelling
Tools
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Problem 1 of Parsing
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>

Parsing a program, model or document, or a material means to recognize its context-

free structure in the linear stream of characters
= Parsers are usually the first phases of a tool when it imports a material

Parsers parse according to the concrete syntax grammar containing
=  Whitespace handling
= Block handling (brackets)
= Comment handling
From a context-free grammar, a parse automaton with parse rules can be derived:

= Address ::= Streetname StreetNumber Location
= Location ::= Postcode Town Country

Generates the parse rules
= Streethname StreetNumber Location — Address

= Postcode Town Country — Location

The parser reads in all tokens until it can decide which rule to reduce



String/Text Parsing with Grammars
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> A grammar can be used to generate a parser for strings (texts) that tests the legality of

a string with the grammar
» The parser checks <<instance-of>> for the string p with regard to the grammar g

S <<reified-
M3 <<collection>> to>> <<Metaclass>>
Set of Grammars EBNF
R Y ”””””””””””””””
Z%«element—of» <<instance-of>>
<<reified
llect; o> |
<< >> << >>
M?2 co ectlc?n Class
Set of Strings g:Grammar
v
Z% <<(legal)
_element-of>>
- <<instance-of>>
M1 p:String I —— |
| parsing
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EBNF Rules for String Grammars
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Symbol
Name (Nonterminal)

"text"

9 oo

+, also juxtaposition

@
[..]-..]

n{..}m

*

n

n+

<a>b

SYN
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Meaning
|dentifier (for type or variable)

Token (text terminal)

Consists of

Sequence

Key (unique identifier)

Selection (alternative)

Iteration, at least n upto m times

Iteration of n - arbitrarily many times
lteration of n at least once

Optional

Sequence of A with intermittend !
Comment

Modifier (Kommentar)

Synonym fur Name

Example

A=B+C

B:="Town" + R
X:=X1+X2+X3
X::=X1X2X3

P = @PersonNr + N + Address
P=[P1|P2]

B=1{C}10

Children ::= Name *
PastEmployers ::= Name +

Address ::= Street + ( PostBox )

C — D// u’v
X =B+ C *text*

<old>A<new>A

SecondName SYN SurName



Example: Address Grammar
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>  “:="means “is-composed-of” or “is-decomposed-to”
> Every rule declares a whole-part decomposition

» Grammar declares the structure of a part list

Address ::= Person Company Location.

Person ::= Title Name

Title ::= ,Or.“ | ,Prof. Dr.“ | ,Mr.“ | ,Ms.®
Name ::= FirstName* LastName

Company ::= String

Location ::= Street StreetNumber Postcode Town
FirstName ::= String

LastName ::= String

Postcode ::= 5{Digit}5

Street ::= String

StreetNumber ::= Integer [ String ]

Town ::= String




Example: ANTLR www.antlr.org
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> Since the 90s, many parser generators have been built for C/C++
= Cocktail's lalr, ell, lark www.cocolab.de
= Fnc2 (INRIA)

= flex und bison (GNU)
= Eliis afast compiler generator toolset http://eli.sf.net

» For Java, ANTLR is popular
= Parser class LL(k): Left-recursive grammar rules, k-lookahead for decisions
= Generated Parser with algorithm “recursive descent”
= http://www.bearcave.com/software/antlr/antlr_expr.html


http://www.cocolab.de/
http://eli.sf.net/
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20.1.2 Program Interpretation While Parsing



An ANTLR Grammar for the Input Language of Pocket
Calculator

19

Model-Driven Software Development in Technical Spaces (MOST)

@ © Prof. U. ABmann



grammar Expr;

Qheader {

package test;

import java.util.HashMap;

20 Model-Driven Software Development in Technical Spaces (MOST) }

@lexer: :header {package test;}

@members {
/** Map variable name to Integer object holding value */
> Pocket calculator interpretes HashMap memory = new Hashiap();
the program to calculate one prog:  stat+ ;
attribute $value stat: expr NEWLINE {System.out.println($expr.value);}
| ID '=' expr NEWLINE
- |nterpretati0n {memory.put ($ID.text, new Integer ($expr.value)) ;}
| NEWLINE
needs non-terminal expr,returns [int value]
: H : e=multExpr {$value = $e.value;}
attrIbUteS’ WhICh ( '+' e=multExpr {$value += $e.value;}
are stored on the | '-' e=multExpr {$value -= $e.value;}
)*

stack of the parser

multExpr returns [int value]
e=atom {$value = $Se.value;} ('*' e=atom {$value *=

» Usually, the parse automaton Se.value;})*
with the parse rules is not atom returns [int value]
ol . : INT {$value = Int . Int ($INT.text) ;}
shown, because it is rather | e pRnEeE )
{
Comp|eX Integer v = (Integer)memory.get ($ID.text);
if ( v!=null ) $value = v.intValue():;
» Debugging a generated parser else System.err.println("undefined variable "+$ID.text);
. }
IS NO fun | '(' e=expr ')' {$value = $e.value;}
// léxical rules
ID :  ('a'..'z'|'A'..'Z')+ ;
INT :  '0'..'9'+ ;
NEWLINE: '\r'? '\n’' ;
WS (" "1'\t")+ {skip();} ;

@ © Prof. U. ABmann



Control of a Generated Java Parser
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import org.antlr.runtime.*;

public class Test {
public static void main(Stringl] args) throws Exception {
ANTLRInputStream input = new ANTLRInputStream(System.in);

ExprLexer lexer = new ExprLexer(input);
CommonTokenStream tokens = new CommonTokenStream(lexer);

ExprParser parser = new ExprParser(tokens);
parser.prog();
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Applications of String Grammars
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Everything that has to do with ordered strings:
> Protocol checking in component-based systems (protocol automata and grammars)

» Document processing
» Matching text patterns and data mining in files, emails, streams

» Communication in multi-agent systems
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20.2 Regular Tree Grammars

eString grammars are for structuring sequences
oRTG are for specifying trees, syntax trees and
abstract syntax trees

e A RTG does not care about concrete syntax



Regular Tree Grammars

http://hydra.nixos.org/build/23332578/download/1/manual/
chunk-chapter/demo-sdf.html#idm140737305321888
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» String Grammars assume:
=  Sequence of words

= |mplicit syntax tree,
because non-terminals
specify it implicitly

» Regular Tree Grammars specify
the tree directly, with tree node
constructors

» ENBF-rule for Tree Grammar Rule:

TreeNode - constructor (" Treenode // ') ")’

»  Example:

Model - ModelElements *

// Regular Tree Grammar from Stratego
regular tree grammar TIL

start Program

productions

Program

Stat
Exp
Stat
Stat
Stat
Stat
Stat
Stat
Stat
Stat

-> Program(ListStarOfStatO)
-> ProcCall(ld,ListStarOfExpO)
-> FunCall(ld,ListStarOfExpO)
-> For(ld,Exp,Exp,ListStarOfStatO)
-> While(Exp,ListStarOfStat0)
-> |fElse(Exp,ListStarOfStatO,ListStarOfStat0)
-> |[fThen(Exp,ListStarOfStat0)
-> Block(ListStarOfStatO)
-> Assign(ld,Exp)
-> DeclarationTyped(ld,Type)
-> Declaration(ld)

ListStarOfStat1 — Stat//
ListStarOfStatO — Stat *

Type

Exp
Exp
Exp
Exp
Exp
Exp
Exp
Exp

StrChar
String

Int

-> TypeName(ld)
-> Or(Exp,Exp) | And(Exp,Exp)
-> Geq(Exp,Exp) | Eq(Exp,Exp) | Neq(Exp,Exp)
-> Gt(Exp,Exp) | Lt(Exp,Exp)| Leq(Exp,Exp)
-> Sub(Exp,Exp) | Add(Exp,Exp)
-> Mod(Exp,Exp) | Div(Exp,Exp) | Mul(Exp,Exp)
-> String(String)
-> Int(Int) | Var(ld)
-> False() | True()

-> <string>
-> <string>

-> <string>



Correct Instance?
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/[ Example: applying TIL grammar to a fragment

ExecuteGrammar(TIL,
While(Neq(Var(x),Var(y)), Assign(Var(x),Plus(Var(x),Int(1) ) )

)




Tree Parsing with RTG
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» An RTG can be used to generate a tree parser that tests the legality of a code tree with
atree grammar

1 . <<reified-

M3 <<collection>> “"°"°"  <<Metaclass>>
~ Setof RTG - RTG Metamodel
b / V

ﬁx«element—of» <<instance-of>>
<<reified
<<collection>> -to>>
<<Class>>
M2 Setof Syntax ™
Trees Tree Grammar

v
Z% <<(legal)
_ ‘erlement-of>>/,_,/

<<instance-of>>

M1 p:CodeTree AT
~— RTG
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Tree Pretty-Printing with RTG
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» An RTG can be used to generate a tree pretty-printer that prints the nodes of a tree

recursively
» |fpisacodetree, p'can be its pretty-printed copy, derived of a code template t

> Exercise: write a pretty-printer for the RTG TIL

| . <<reified-
M3 <<collection>> ““°1°"  <<Metaclass>>
Setof RTG - RTG Metamodel
T e / ,/::,iv,,,,,,,,,,,,,,,,,,,,,,,,.‘
ﬁx<<e|ement—of>> <<instance-of>>
<<reified
i -to>>
M2 <<collection>> <<Class>> <<Class>>
Setof Syntax — ®™ .
Tree Grammar String Grammar
Trees
1 A
<<(legal) <<inst§nc’é—of>> |
element-of>> ’ Cod <<instance-of>>
M ” Templat |
emplate
p:CodeTree | P
RT_G = p':Code
,,,,, printing

@ © Prof. U. ABmann
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20.3. Tree Construction as a Mapping between
Parse Grammar and Tree Grammar

e Foll parser also build syntax trees - Design Pattern Builder



Tree Construction While Parsing
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>

>

Parsing recognizes the tree structure of a text - however, the syntax tree must be
built

After parsing, the parser creates an (abstract) syntax tree, i.e., builds up a tree with
regard to a regular tree grammar of the abstract syntax

= Recognized nonterminals have to be mapped

= Tokens, keywords, comments, layouts have to be omitted

= Tree building: Treenodes have to be allocated
This CS-AS mapping (from concrete to abstract syntax) is created by hand in side
actions of the parser
For simple languages, parsers and tree constructors are no longer written by hand, but
generated from grammars in EBNF

= Parser recognizes the structure of the text (“Zerteiler des Textes”)

= Tree builder generates an abstract syntax tree

= CS-AS-mapping creates AS nodes after recognition of CS nonterminals



Constructing a Tree Grammar fitting to the String Grammar
of Office DSL

33

Model-Driven Software Development in Technical Spaces (MOST)

@ © Prof. U. ABmann

//**************************************************'k****************************

// Copyright (c) 2006-2010

// Software Technology Group, Dresden University of Technology

//

// All rights reserved. This program and the accompanying materials

// are made available under the terms of the Eclipse Public License v1.0
// which accompanies this distribution, and is available at

// http://www.eclipse.org/legal/epl-v10.html

//

// Contributors:

//  Software Technology Group - TU Dresden, Germany

// - initial API and implementation

// **************************************************-k***************************/
SYNTAXDEF office

FOR <http://emftext.org/office>

START OfficeModel

OPTIONS {
licenceHeader ="../../org.dropsbox/licence.txt";
generateCodeFromGeneratorModel = "true";
disableLaunchSupport = "true";
disableDebugSupport = "true";
}
RULES {
OfficeModel ::= "officemodel" name[] "{" elements:Element* "}" ;
Elements ::= Office | Employee;
Office ::= "office" name[];
Employee ::= "employee" name[]
"works" "in" worksIn[]
"works" "with"
workswith[] ("," worksWith[])* ;
}




.CS Grammar Plus Mapping to RTG (Abstract Syntax Tree)

34 Model-Driven Software Development in Tech
» CS-AS mapping works
via side actions of the
grammar rules
» Tree is built while

@ © Prof. U. ABmann

returning from
recursive descent

//*********************************************************

// Copyright (c) 2006-2015 under EPL

// Software Technology Group, Dresden University of Technology
// http://www.eclipse.org/legal/epl-v10.html

//

//********************************************************/

SYNTAXDEF office FOR <http://emftext.org/office>
TREENODES { // RTG

START NodeOfficeModel

NodeOfficeModel -

NodeOfficeModel(name:String, elements:Element *)

Element - Office(name:String) |

Employee(name:String, worksIn:String,
workswWith:String *)
}
START OfficeModel
RULES {
OfficeModel returns [NodeOfficeModel root]
::= "officemodel" name[] "{" elements:Element * "}"
{ root = NodeOfficeModel()
root.name = name; root.elements = assemble elements; };
Elements returns [Element retval]
::= O0ffice { retval = Office.val; }
| Employee { retval = Employee.val; },;
Office returns [Element retval]
::= "office" name[] { retval = Office(name); };
Employee returns [Element retval]

::= "employee" name[] "works" "in" worksIn[]
"works" "with"
workswith[] ("," workswith[])*

{ retval = Employee(name,worksIn,assemble workswWith);

I




Modeling Tools need Several Languages and DSL
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» Bidirektional mapping between technical space “Grammarware” and another one, e.g.,
“Treeware”, “Link-TreeWare”, “XMLWare”, or “Modelware”

How can an MDSD Tool work flexibly
with several textual languages?

Generating parsers and tree builders from string grammars and
RTG

... and generate from the RTG ..

Pretty printers (Code generators)

@ © Prof. U. ABmann



Example: EMFText: EMOF and RTG
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» EMFText uses the parser generator ANTLR to generate parsers
» The EMOF metamodels have a primary tree that can be written down as RTG

» Mapping concrete to abstracte syntax:

= EBNF Grammar and the (implicit) RTG of the corresponding EMF
metamodel are mapped automatically to each other (language mapping)

> For pretty printer generation, EMFText uses template-based code generation for the
(implicit) RTG
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10.4 Text and Tree Algebrae



Composition with Composition Systems
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Composiﬁon Technique

- ™ OProf.U. ABmann



Composition with Algebrae in Mathematics
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Composiﬁon Technique:

Algebra Operators
(union, unify, etc.)
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One-sorted Algebra on Texts

40

Model-Driven Software Development in Technical Spaces (MOST)

@ © Prof. U. ABmann

A one-sorted algebra is a set of operators on a carrier set (Tradgermenge) of a type (a
sort). Example: Texts, sequences of lines of characters

Operations

= E.g.,the parser splits texts into lines, separated by newline characters

= Atexttemplate is expanded by a padding (Fullsel)

The UNIX Programmers Workbench is built on an algebra on texts:

x Text » edit-sequence (foratransformation)

Text x yours:Text -» edit-sequence
> Text*

X Pattern -» Text*

X Pattern -» Boolean

X Text -» Boolean

diff: Text

cmp : Text x Text -» Boolean
patch: Text x edit-sequence -» Text
diff3: mine:Text x older:

split: Text x Split-char
match/grep: Text
check-property: Text
is-consistent: Text

format: Text -» Text

expand: Text-template x padding:Text* -» Text



CSV: A One-Sorted Algebra on Ascii-Tables
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» Tables consist of sequences of lines, split into columns by a column-separator (TAB,
COMMA, |)

= csv-tables (comma separated values)
= html-tables, tex-tables

» rdbisacommand tool suite on an algebra on tables:
« Diff: table x table » edit-sequence
= Cmp: File x File » Boolean
« Patch: table x edit-sequence -» table

= Diff3: mine:table x older:table x yours:table -» edit-
sequence

= split: table x Splitzeichen -» table*

= match: table x Pattern -» table*

= Ccheck-property: table x Pattern -» Boolean
m is-consistent: table x table -» Boolean

= join, sort, group-by...

= format: table -» table

= expand: table-template x table* -» table

@ © Prof. U. ABmann



Tree Algebra
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>

Operations in a simple algebra on trees:

Diff: tree x tree -» edit-sequence

Cmp: File x File » Boolean

Patch: tree x edit-sequence -» tree

Diff3: mine:tree x older:tree x yours:tree -» edit-sequence
split: tree x node -» upper:tree x lower:tree
match: tree x Pattern -» tree*
check-property: tree x Pattern -» Boolean
is-consistent: tree x tree -» Boolean

Unify: tree x tree -» tree

format: tree -» tree

expand: tree-template x padding:tree* -» tree
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20.5 Port-Graph Algebrae on Fragments

Invasive Software Composition is a general, typed templating technique for all
languages

... based on port-graph algebrae
... with Graybox Components
... preview onto the summer (CBSE course)



“Invasive” Composition (Typed Templating) with Port-Graph
Algebrae
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Composition Technique:

Hook Transformation

Jj 1 © Prof. U. ABmann




Invasive Composition as Hook Transformations
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A port graph is a graph in which each
node (molecule) has a set of ports

A fragment component is a molecule
with ports (slots, hooks, query points)
related to change points

Invasive Composition
adapts and extends
fragment components

Invasively transformed tags at ports (slots, hooks, query-points)
by composition operators
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Binding Implicit Hooks with Fragments
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Method Entry Method Entry

ethod Exit Method Exit
‘ m ({
m Ot print(“enter m”);
abc.. ggg"
cde. print(“exit m”);
}

component.findHook(,,.MethodEntry*).extend(“print(\"enter m\”);”);

component.findHook(,MethodEXxit*).extend(“print(\"exit m\");™);
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Partial Parsing of Fragment Components
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Method Entry

Method Exit

m ()
m (){ ‘ /I Method Entry
abc.. ?32"
cde.. // Method Exit
} }

Component = compositionSystem.partialParser(,m (){ abc.. cde.. }");




Binding Declared Hooks with Fragments
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Element Element

‘ List(Apple) list;

jist.add(new E()): list.add(new Apple());

List(E) list;

box.findHook(,Element®).bind(“Apple™;
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Invasive Composition as Hook Transformations
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[ FO

N rd

Composer

J
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Invasively transformed tags

Invasive Composition works uniformly

on

For all languages

For declared hooks and
implicit hooks

Allows for unification of

Inheritance

Views

Aspect weaving
Parameterization
Role model merging



Operators in a Port-Graph Algebra
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Simple composition operators

>

bind hook (parameterize)

= For generic programming
rename component, rename hook
remove value from hook (unbind)
extend component or hook
extensions

copy fragment component

Compound composition operators
> inheritance from component

= For object-oriented
programming
> view of component
= view-based programming
» connect hook 1 and 2
= For connector-based
programming
» distribute component over other
component

= For aspect weaving
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20.6 Pseudocode and Markup Languages

http://en.wikipedia.org/wiki/Pseudocode



Pseudocode

52 Model-Driven Software Development in Technical Spaces (MOST)

» Pseudocode consists of structured text with keywords and blocks, z. B. seq, endseq, if,
then, else, endif, while, endwhile, call, action, stop....

= Natural text is enclosed as comment, but ignored
» For pseudocode, grammars can be constructed:
= Syntax checking with island parsing

= Anisland grammar contains
“islands” for the keywords and structure

“water” for the free-form text

> Tool support:
= Code generation (code templates and comments)

= Documentation generation (structograms, LaTeX document generation)

@ © Prof. U. ABmann



Examples for Pseudocode

53

Model-Driven Software Development in Technical Spaces (MOST)

> |n pseudocode, structure can be recognized (as islands in the free-form water)

» Pseudocode canrecognize names and do a name analysis:
= Title of procedures, classes, and processes
= Types from the data dictionary, Local names

» Pseudocode can define macros

process empfangen_Patient 1.3.1
for &Patient
with >Bestelldatum = Datum in &Termine und >Beschwerden

if Name*des Patienten* in &Patient

else "aktualisieren_Patient 1.1"

if keine >Beschwerden und >Bestelldatum ungueltig
then ,vergeben_Termin 1.2“

else Uebernahme Patientendaten aus &Patient

alle Unterlagen fuer Arzt aufbereiten

<Aufnahme Name*des Patienten* 1in &Warteliste

if @Bestdat+Zeit = Kalenderdatum + Uhrzeit

then Terminpatient Platz m+1*
vorhergehender Terminpatient m*

else Platz n+1*n Anzahl aller Patienten im Wartezimmer?*

@ © Prof. U. ABmann




Structural Skelecon of Pseudocode (2)
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action empfangen Patient
= while (Patienten oder Praxisoeffnung)
= seq Eingabe >Bestelldatum, >Beschwerden
— if (@Bestdat+Uhrzeit enth. &Termine)
- then Bestellpatient
else if (@Gebdatum+Name enth. &Patient)
then ziehen Patientenakte
else call aktualisieren Patientendaten
endif
if (>Beschwerden <> (O*vorhanden¥*)
— then Unbestellter Patient
else call vergeben Termin
endif endif
Aufbereiten aller Unterlagen fuer Arzt endseq
— if (Bestellpatient)
then <Aufnahme Platz m+l in &Warteliste
else <Aufnahme Platz n+l in &Warteliste

endif endwhile

stop
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LATEX, XML and Pseudocode
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>

Markup languages structure pseudocode with markup tags.

\documentclass{article}
\title{My first Document}
\author{John Doe}
\usepackage[english] {babel}
\begin{document}

\maketitle

Hello World! My name is John Doe.

\emph {Next paragraph has to be written.}

\end{document}




Support for Pseudocode
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» LaTeX-distributions have good style packages for pseudocode:
= algorithms.sty
= \usepackage{algpseudocode}

PACKET stack handling DEFINES push,pop,init

= \usepackage{algorithmicx} stack:
LET max = 1000;
- Iistings sty ROW max INT VAR stack;
) INT VAR stack pointer;
> See also ELAN, the semi-natural N tack poimmer = 0
. END PROC init stack;
programming language PROC push (INT CONST dazu wert):

stack pointer INCR 1;

= http://de.wikipedia.org/wiki/ELAN IF stack pointer > max

THEN errorstop ("stack overflow")
- Part Of OS L3’ predecessor Of L4 ENELii stack [stack pointer] := dazu wert

END PROC push;

PROC pop (INT VAR von wert):
IF stack pointer = 0
THEN errorstop ("stack empty")
ELSE von wert := stack [stack pointer];
stack pointer DECR 1
END IF
END PROC pop

END PACKET stack handling;

= http://os.inf.tu-dresden.de/L3/usrman/node10.html
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Summary
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>

>

Parser generators belong to the tool set of a software engineer

Parsers can parse
=  Texts (lines of rows)
= CSVrelations (lines of delimiter-separated tuples)
= Pseudocode with island grammars

The parser only parses the context-free structure of the programms, document, or
model;
Syntax trees are built from a mapping of concrete to abstract syntax

Context conditions, integrity and wellformedness constraints are delayed to the static
semantic analysis on the syntax tree



The End
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> Why is a parser often delivering several results (parses)?

» How can you disambiguate ambiguate rules?
»  Why is string parsing not the same as tree parsing? What is the difference of concrete
and abstract syntax trees?
> Explain the difference of
= Astring grammar vs a tree grammar

= A concrete syntax grammar (CS grammar) vs an abstract syntax grammar
(AS grammar)



